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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Warranty and Repair Policy

Ross Video Limited (Ross) warrants its Streamline Server systems to be free from defects under normal use and 
service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your Streamline 
Server system, contact your regional sales manager.



Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Use of Hazardous Substances in Electrical and Electronic Products (China RoHS)

Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html


Company Address

Ross Video Limited 

8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com

E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com




Xchange Suite MAM Panel for Adobe Premiere Pro User Guide (v2020) Contents • i

Contents

Introduction 1
A Word of Thanks ................................................................................................................................................1-1
About This Guide ..................................................................................................................................................1-2
Documentation Conventions .................................................................................................................................1-2

Interface Elements ..............................................................................................................................................1-2
User Entered Text ..............................................................................................................................................1-2
Referenced Guides .............................................................................................................................................1-2
Menu Sequences .................................................................................................................................................1-2
Important Instructions ........................................................................................................................................1-3

Contacting Technical Support ...............................................................................................................................1-3

Getting Started 2
Setting Up the Xchange Panel in Adobe Premiere Pro .........................................................................................2-2

Projects 3
Starting a New Premiere Project ...........................................................................................................................3-2
Saving a Project ....................................................................................................................................................3-4

Managing Large Projects 4
Adding Additional Assets to a Large Premiere Project ........................................................................................4-2
Organizing an Adobe Premiere Pro Project ..........................................................................................................4-3

Importing Assets 5
Importing Assets Into Xchange from Premiere Pro ..............................................................................................5-2

Xchange Project Creation ..................................................................................................................................5-2
Importing Through the Premiere Panel .................................................................................................................5-3

Creating Xchange Project Bins for Each Card/Reel 6
Creating Project Bins ............................................................................................................................................6-2
Adding Metadata ...................................................................................................................................................6-3
Batch Metadata Duplication .................................................................................................................................6-5
Xchange (MAM) Upload Email ...........................................................................................................................6-6

Actions in the Xchange Panel 7
Import Media ........................................................................................................................................................7-2
Replace Project Media ..........................................................................................................................................7-3
Export Sequence to Disk .......................................................................................................................................7-4
Export Sequence to Xchange ................................................................................................................................7-5
Register Media to Xchange ...................................................................................................................................7-6
Save Adobe Project to Xchange ...........................................................................................................................7-7



ii • Contents Xchange Suite MAM Panel for Adobe Premiere Pro User Guide (v2020)



Xchange Suite MAM Panel for Adobe Premiere Pro User Guide (v2020) Introduction • 1–1

Introduction

A Word of Thanks

Thank you for choosing Ross Video Xchange Suite as your media asset management solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team is more than happy to provide further information on the plans available. 
Members of our sales team will promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Xchange Suite media asset management solution from Ross Video. We are 
confident of your future pleasure with your choice.

Yours Sincerely,

Alan Dabul
Product Manager - MAM + Media IO
adabul@rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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About This Guide

This guide contains the following chapters that cover the use of the Xchange Suite MAM Panel for Adobe Premiere 
Pro:

1. Introduction — summarizes the guide and provides important terms, and conventions.

2. Getting Started — outlines the steps required to set up the Xchange Panel in Adobe Premiere Pro.

3. Projects — outlines the steps required to download your company Xchange Project template and begin using it 
in Premiere Pro.

4. Managing Large Projects — outlines the steps required to add media assets to large Projects and how to 
organize them.

5. Importing Assets — outlines the various methods used to import assets and the steps involved. 

6. Creating Xchange Project Bins for Each Card/Reel — outlines the steps required to properly create 
Xchange Project bins and set up the required metadata.

7. Actions in the Xchange Panel — outlines the various Actions that are available to users in the Xchange Panel, 
including Import Media, Replace Project Media, Export Sequence to Disk, Export Sequence to Xchange, 
Register Media to Xchange, and Saving an Adobe Project to Xchange.

If you have questions pertaining to the operation of Xchange Suite, please contact us at the numbers listed in the 
section ““Contacting Technical Support” on page 1–3”. Our technical staff is always available for consultation, 
training, or service.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Assets panel, click Delete.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Managing Large Projects” in the Xchange Suite MAM Panel User 
Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.
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Important Instructions

Star icons are used to identify important instructions or features. For example:

 After upgrading Xchange Suite software, you must obtain feature licenses from Ross Video Technical Support 
before users can access Xchange Suite features.

Contacting Technical Support

Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 844-652-0645

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

Our telephone number is: +44 (0)1189502446

International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia

Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: 1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Online

E-mail: techsupport@rossvideo.com 

Website: open a support request using the link http://www.rossvideo.com/support/tech-support.html to open a 
support request.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com/support/tech-support.html
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Getting Started
The Primestream Xchange™ Panel for Premiere® Pro is an Adobe® extension used to access the Xchange MAM 
via Adobe Premiere Pro. The Xchange Panel enables users and teams to create, share and collaborate with post 
production projects using a built-in plugin for Adobe Premiere Pro. Users can organize raw footage, or final edited 
programs with various languages within a single workspace.

Figure 2.1  — Xchange User Interface

This chapter discusses the following topic:

• Setting Up the Xchange Panel in Adobe Premiere Pro
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Setting Up the Xchange Panel in Adobe Premiere Pro

To begin using the Xchange Panel, there are some steps that you must take to get the extension set up and ready to 
use in Adobe Premiere Pro.

To set up the Xchange Panel in Adobe Premiere Pro

1. Open the Premiere Project Template initially provided through the Xchange Project.

2. Inside Premiere Pro, click on the Project File Template tab named Primestream Xchange.

3. Log in with first and last name and use the same password as your email account.
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4. If the Xchange panel window does not initially appear, you can launch it by navigating to Window > 
Extensions  > Primestream Xchange.

5. After selecting the Xchange panel, it will open on top of the Premiere application.

OPTIONAL — Drag panel into an Adobe Premiere Pro window to embed it as a tab in any workspace.

6. Save the Workspace in Premiere as Primestream Xchange
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Projects
“Projects” are containers that hold assets. [COMPANY NAME] has Xchange and Premiere projects. This workflow 
explains how Xchange Projects allow Premiere Projects to be standardized by templates, worked on locally and 
saved for back up or sharing.

This chapter discusses the following topics:

• Starting a New Premiere Project

• Saving a Project
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Starting a New Premiere Project

To begin working with the Xchange Panel in Adobe Premiere Pro, you will need to create a new Premiere Project to 
use. This Project will contain the assets used.

To start a new Premiere Project

1. Using Chrome, navigate to [Your company web address].

2. Login with first and last name and use the same password as your email account.

There is a [COMPANY NAME] approved template created in the root of each Xchange Project. The template 
is set up to Tech and Post's specifications and will be best for the [COMPANY NAME] environment.

3. Download the [COMPANY NAME] approved Project template.

4. Navigate to the Xchange Project for the episode. Selecting the episode asset will bring up the video preview 
window and info panel on the right side of the interface.
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5. Download the Premiere Project to a local drive, preferably in a documents folder or somewhere it can be easily 
retrieved.

6. Using Adobe Premiere Pro, open the Premiere Project and work with it locally. This improves performance and 
prevents multiple users from accessing the same project simultaneously.

7. Once Premiere is open and with the episode appropriate project, log into the Primestream Xchange Panel using 
the same email log in and password.
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8. Navigate back to the same Xchange Project that held the Premiere Project. Source media should be loaded in 
there as well. Highlight all the media needed for the edit and go to Actions > Import Media to pull in all the 
organized media.

Saving a Project

Premiere Projects begin as a template within Xchange and during editing, live on local hard drives. Saving a 
Premiere Project in Xchange provides a backup system at any step along the way. Premiere Projects saved in 
Xchange can be accessed by other users to tag team edit, share assets or review completed or work in progress.

To save a Project

1. In the Xchange panel, go to Actions > Save Adobe Project to Xchange.

2. Name the project something that will provide metadata for later searches. Consider adding dates or versions 
into the name to later search them easily in Xchange.

3. Add descriptions for additional searchable metadata.
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4. Select the appropriate Xchange Project to receive this copy of the Premiere Project.

5. Click Save Project To Xchange for Premiere to make a copy of the currently open Premiere Project into the 
Web based Xchange Project.

This puts a copy of the Premiere Project, in its current state, into the Xchange project. It is a great tool for 
versioning, backing up work and a quick way to collaborate.

• When the edit resumes, launch Premiere Pro.

• Open the project within Premiere Pro and continue to edit.

 This function DOES NOT move the currently working project file. It's a versioning tool, and a way to share 
project files in a central location.
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Managing Large Projects
Adobe Premiere Pro Projects accumulate multiple assets quickly. When a Project that you are working on grows 
large, you may find that changing how you approach a task is needed for efficiency. Keeping the files organized and 
clutter-free will also help when working with large Premiere Projects.

This chapter discusses the following topics:

• Adding Additional Assets to a Large Premiere Project

• Organizing an Adobe Premiere Pro Project
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Adding Additional Assets to a Large Premiere Project

Once a Premiere Project is large, adding more clips from the MAM (even just one) requires a scan that can take a 
great deal of time. [COMPANY NAME] has created a customized work around for this specific situation. AE's or 
Editors adding assets will follow this protocol.

To add additional assets to a large Premiere Project

1. Open a blank Premiere Project.

2. Log into the Xchange Panel and import the new assets from Xchange into the blank Premiere Project.

With a few assets, it takes very little time. As the number in the “blank” Premiere Project grows, importing 
from Xchange will slow down. Try not to make the addition as large as the original Premiere Project or this 
workaround is not effective.

3. Save the Premiere Project. Name it something recognizable that relates to the original project. Remember 
where that is saved for later retrieval.

4. Send the location or the Premiere Project file to the editor who needs to add the assets.

The editor should browse to the Premiere Project location and try to open that Premiere Project within the main 
Premiere Project.
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Premiere can't have two projects open simultaneously. The assets from the second Premiere Project appear in 
the media browse window and can be opened into the original Premiere Project.

This workflow maintains the Log Notes to switch between assets in the future, but avoids the wait time to 
import more assets into a large project when doing it through Xchange.

Organizing an Adobe Premiere Pro Project

Delete miscellaneous files and move everything to the reel/card root folder. The Premiere Project should look clean 
and simple. 

Figure 4.1  — Example of a Premiere Project file that has been organized

If the Primestream Xchange panel isn’t open, you can launch it by navigating to Window > Extensions  > 
Primestream Xchange.

Figure 4.2  — Menu sequence to manually launch Xchange
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Importing Assets
Importing is the process that copies clips on shared storage while placing the assets in the Xchange Media Asset 
Manager. There are two methods to import, through Xchange on a Web browser such as Chrome or through the 
Primestream Xchange Panel in Adobe Premiere Pro. Both methods produce the same results. Which method is used 
partially depends the type of media being imported.

This chapter discusses the following topics:

• Importing Assets Into Xchange from Premiere Pro

• Importing Through the Premiere Panel
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Importing Assets Into Xchange from Premiere Pro

 Importing assets should not begin until a Project has been made in Xchange to receive the incoming clips. 
Xchange Projects are made in the Xchange Web interface. 

Xchange Project Creation

Xchange Projects are buckets or receptacles for all assets used in an episode. Check Xchange Projects to see if one 
already exists for the episode about to be imported. If it is there, this can be skipped - otherwise...

To create an Xchange project

1. Login to Xchange by visiting http:// [Your company web address] and login with your Active Directory (AD) 
credentials.

The bottom left of the interface has a project panel. The bottom of the panel has a + and a - button.

2. Hit the + button to create a new project.

3. Once the dialogue pops up, input the information below. Star icons indicate MANDATORY information to get 
the project started, but the Ingest Operator is responsible for filling out ALL FIELDS.

• Project Name — This is always (EPISODEID)-(SHOW)-(EPISODE#)-(EPISODETITLE), EPISODEID 
must be obtained before ingest. If it's not already piped into the MAM, request it from your administrator.

• Production Server Id — [Your company Server iD]

• Project Type — [Your company Project type] The project drop-down is referencing Premiere Project File 
Templates on the grid.

• Project Metadata — Standard

• Episode ID — [Your Episode iD]

• Division — Select the appropriate division.

• Series/Show — This will eventually have a drop-down, but right now it'll be specific to whatever is dropped 
off. If there is any confusion about what this should be, work it out with DEE creating the Xchange Project.

• Episode_Name — Self Descriptive.

• Episode_Number — Mostly relevant for TV, but will eventually become essential for other series.

• Episode_Description — Not mandatory at this time, and should eventually pipe in from Insider.

• Episode_Status — You can switch this to Ingest.

• Approval Status — Pending

• Producer — Should be on INGEST/PPS Form when dropped off to avoid confusion.

• Post_Supervisor — Should be on INGEST/PPS Form when dropped off to avoid confusion.

• Project_Location — Don't worry about this field

• Project_Archive — Don't worry about this field

• productionOffice — Brooklyn, NOT NYC, NOT BK NOT NY. Must be Brooklyn
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Access: 

a. Under Groups — MAM-Ingest

b. Under Users — Designate to the Post Super and the AE of the project only at this time.

4. Push Create

The Xchange project will now appear in the list, with an Adobe Premiere Pro project inside. Now there is a 
container to receive newly ingested material.

Importing Through the Premiere Panel

Importable Media — Any self-contained asset such as AUDIO or FS7 or A7S footage can be imported through 
Primestream Xchange panel, no spanned media can be imported directly through Xchange. Lightspeed must first be 
used to stitch clips together. 

Mandatory Criteria — There are four critical pieces of information that must be available before importing begins. 
These represent the mandatory metadata that will be on the ingest form:

• VPSID

• EPISODE ID

• PRODUCER

• LOCATION

To import through the Premiere Panel

1. Open the MAM_INGEST Premiere Project.

2. Drag and drop media from the source or origin (local drives, cards) into the Premiere Project.

Several junk files appear. For example, in the AUDIO folder, the SDINFO.TXT and a folder deeper down that 
contains the audio. In the A7S folder, there is the M4ROOT folder and the camera-created thumbnail. 
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Creating Xchange Project Bins for 
Each Card/Reel
Each card/reel will have its own bin in the Xchange project. The name of that bin should be the same name coming 
from the original media. The names are in the Premiere Project. 

This chapter discusses the following topics:

• Creating Project Bins

• Adding Metadata

• Batch Metadata Duplication

• Xchange (MAM) Upload Email
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Creating Project Bins

To use media in a Project, you must have Project Bins where you can store the files. Once media has been imported 
to the Project, it is contained in bins for the different batches.

To create a project bin

1. Copy the name of the first card to be ingested.

2. In the Primestream Xchange panel click on Actions, then select Register Media to Xchange.

“Register” refers to uploading or importing into the Xchange database. The media is about to be copied from its 
current source into Xchange and receive the appropriate information or metadata used as search criteria.

3. The left side of this panel we see the bins holding media in the open Premiere Project.

Each card or bin will be treated as an individual batch. Xchange recognizes these as files about to be registered. 
In the right panel confirm the [COMPANY NAME] Ingest Form is selected. Imported media attaches 
information or metadata from a form. In this configuration, once metadata is created, it can be applied to all 
other batches or cards being imported. This information must be correct otherwise the wrong metadata can 
carry across all batches.
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4. Paste the copied reel/card into the Name field on the right.

5. Then, selecting only 1 reel at a time, check the reel/card in the list on the left. The checked reel card should be 
the same name pasted into the name column in the form on the right

6. Click Add to make the selected reel "Batch 1" (which has been named whatever was copied and pasted).

A list of all the clips on that card/reel should populate under the batch.

7. Navigate to the gear wheel at the bottom of the center panel. Check the Create Project Bins option.

 This will create Xchange project bins for each batch, automatically. If this option is NOT checked, bins will not 
be created. All clips will merge into one project and the bins will have to be created, and media needs to be 
dragged and dropped in manually. This must be checked before the final command to register is initiated.

Adding Metadata

Including metadata is an important step that will help make your media easier to locate. By including as much 
detailed metadata as possible, it will be easier to distinguish between files and find what you are looking for.

To add metadata

1. Profile must be set to proxy edit.

2. Navigate to the Project and Raw Bin. This tells Xchange where to create the new bin with the card name.
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3. With the Project and Bin selected, fill out the [COMPANY NAME] Ingest Form. This incorporates the four 
pieces of mandatory information, noted by the stars.

 FILL OUT EVERY MANDATORY FIELD and put in as much other information as possible. This is an 
opportunity to add searchable metadata to clips. Tags, locations and any other information provides criteria for 
quick and efficient searching in the future.

The only NON-mandatory fields are:

• Technical_Notes 

• English_Language_Material 

• Non-English_Languages 

• Archive_Location 

• Description 

• Tags 

Non-Mandatory categories provide additional opportunity to insert common metadata on a group of clips 
making searching simpler. Once all possible information is filled in, double check EVERYTHING! 

Check list: 

•    Project assigned.

•    Raw footage bin assigned.

•    1st Batch media added to middle Batch column.

•    Complete the [COMPANY NAME] Ingest Form as soon as possible.
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Batch Metadata Duplication

Once all the metadata is reviewed and verified on Batch 1/Reel 1, duplicate the Batch Metadata to attach it 
throughout the remaining reels.

To duplicate Batch Metadata

1. Hit the + sign at the bottom right of Batch 1 to create a new batch.

2. Change camera type or any specific metadata to match the new batch. If shoot dates are different (i.e.: several 
days of footage) change the shoot date.

This is what the panel looks like once all the batches are ready for uploading to the MediaGrid and Xchange 
(MAM).

 TRIPLE CHECK YOUR BATCHES! Make sure all clips are there.

3. Once all the data is correct, click the gear icon one more time to create individual bins within the Xchange 
Project. 

4. Confirm the Create Project Bins box is checked. 

5. Click Register to import the media.

If there are more than 20 items, an alert dialogue may pop up. 
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6. Click Ok and continue.

Xchange (MAM) Upload Email

Once all media is registered to Xchange, send an email to the relevant parties.

SUBJECT:

MAM UPLOAD | [Your company stills directory] | Show - Episode # - Episode Name - Ingest Date
MAM UPLOAD [ | It will display the Episode #, Episode Name and the Ingest Date]

BODY:

Media is now available in the MAM.

EPISODE ID:

[Your company Episode iD]

STILLS:

/Volumes/ [Your company stills directory]

CONCLUSION:

Once the MAM UPLOAD email is sent, that's it! Media is now ready for teams to use. 
RAW media from workhorse drives will continue to be backed up on near-line Servers until further notice. 
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Actions in the Xchange Panel
Actions in the Xchange Panel are steps editors take while working in Adobe Premiere to interact with assets in 
Xchange. Each action has a set of steps editors take to accomplish specific functions.

This chapter discusses the following topics:

• Import Media

• Replace Project Media

• Export Sequence to Disk

• Export Sequence to Xchange

• Register Media to Xchange

• Save Adobe Project to Xchange
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Import Media

This import refers to media that already exists in Xchange.

Media will be copied only when registering new assets into Xchange. When importing into Premiere Pro, media 
files will not be copied to the local station. 

To import media

1. In the Xchange panel, select the media to be imported, and click the Import Media Action.

2. After selecting Import Media, select the quality to import.

3. Next, select Import.

Imports shouldn't take long since pointers are being directed but media is not being copied. When the assets 
arrive, a Premiere Bin named “Media from Xchange” appears with requested assets inside. Future imports will 
place assets into the same bin.

Refer to the Importing Assets chapter for more information.
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Replace Project Media

Editors often edit in one media format and later want to change that format within a sequence or project. Most 
commonly, editors work in proxy video for speed and simplicity, upgrading to original or high resolution before 
final output. “Replace Project Media” seamlessly allows this to happen.

To Replace Project Media

1. In the Xchange panel, go to Actions > Replace Project Media.

2. Select the media asset(s) which are to be replaced.

3. Select the quality the asset(s) will use after the replace.

4. Filters can be used to narrow down the selection.

5. Click Replace Media.

System will show the status and notify when replacement is complete.
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Export Sequence to Disk

This action allows sequences to be exported to disk.

To Export Sequence to Disk

1. In the Xchange panel, go to Actions > Export Sequence to Disk.

2. Select appropriate EPR setting.

3. Click Export Sequence.

Adobe Media Encoder will now render the sequence to the preset chosen and place the file in the Export 
directory configured in the Xchange Panel. No media will be registered into Xchange in this action.



Xchange Suite MAM Panel for Adobe Premiere Pro User Guide (v2020) Actions in the Xchange Panel • 7–5

Export Sequence to Xchange

This action allows sequences to be exported to Xchange.

To Export Sequence to Xchange

1. In the Xchange panel, go to Actions > Export Sequence to Xchange.

The Export Sequence window which allows metadata to be attached and steers the media to the correct 
Xchange Project will appear.

2. Select the appropriate Render Profile. Should be Proxy Edit

3. Select the appropriate Export Preset.

If this step is skipped, Xchange will prompt for a selection to be made.
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4. Select the Xchange Project receiving the export.

If this step is skipped, Xchange will prompt for a selection to be made.

5. Name the media. This is a great opportunity to version work in case there is a reason to step backwards.

6. In the FORMS drop down, select the Export Form. This has all the fields necessary to add metadata to the 
sequence being exported.

7. Fill in remaining metadata fields. Any metadata field with a * must be filled in for the export to work.

8. Click Export Sequence.

A copy of the exported Premiere Sequence will now appear in the designated Xchange Project.

Register Media to Xchange

“Registering” refers to putting new assets into Xchange. Media can be registered to Xchange from cards, local 
drives or any other source. Media on common shared storage like MediaGrid, but not yet registered, can even be 
registered to Xchange. This action will create new media so editors must be aware of which copy is being used in a 
project to avoid media going offline.

This process has several critical steps. Refer to the chapters on “Importing Assets” and “Creating Xchange 
Project Bins for Each Card/Reel” for specific instructions.
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Save Adobe Project to Xchange

Premiere Projects begin as a template within Xchange and during editing, live on local hard drives. Saving a 
Premiere Project in Xchange provides a backup system at any step along the way. Premiere Projects saved in 
Xchange can be accessed by other users to tag team edit, share assets or review completed or work in progress.

Refer to the section on “Saving a Project” in the “Projects” chapter for specific instructions.
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